UPGRADING LAPTOPS AND DESKTOPS TO THE NEW HP ELITEBOOK
FOLIO 9470M AND HP ELITEDESK 800 G1 DESKTOP MINI BUSINESS PC

Get a faster, more responsive experience

by replacing your older desktop or notebook

1.3X
the
battery
life

Space-
saving
design

HP EliteDesk 800 G1 mini HP EliteBook 9470m

versus HP Compaq 8000 Elite versus HP EliteBook 8460p

Laptops and desktops that were once top-of-the line have been eclipsed by new
technologies that can boost performance and speed up employee processes. Letting
your employees’ work lag behind on older systems can waste precious time that they
could spend getting more work done.

In the Principled Technologies labs, we did a series of hands-on tests to show
how you could benefit from upgrading an older HP EliteBook 8460p laptop to a new
Intel® Core™ i7-3687U processor-powered HP EliteBook Folio 9470m and an older HP
Compaq 8000 Elite desktop PC to a new Intel Core i7-4765T processor-based HP
EliteDesk 800 G1 Desktop Mini Business PC.

The results were clear. Not only does the new HP EliteDesk 800 G1 Desktop Mini
come in a small form factor, which saves space, it also completed tasks such as booting
33.8 percent faster and got an HDXPRT (which assesses digital media performance)
score 85.0 percent higher than the older desktop. The new HP EliteBook Folio 9470m
laptop also outperformed its legacy system in tasks such as booting in 40.1 percent less
time and lasted up to 1 hour 26 minutes longer on a single battery charge.

When employees complete these types of task day in and day out, company-
wide, the time savings and productivity boost you get by upgrading systems across your

organization can be dramatic.
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IT ALL ADDS UP TO AN UPGRADE

Even laptops and desktops that have served you well eventually need to be
replaced. By upgrading to new systems, you can save employees time on tasks they
complete every day. We found that the new HP EliteBook Folio 9470m laptop and HP
EliteDesk 800 G1 Desktop Mini (DM) were good targets to upgrade to, as they shaved
time off of most tasks and showed better overall system performance compared to the
older HP EliteBook 8460p and HP Compaq 8000 Elite Desktop PC. Upgrading to these
systems has the potential to increase productivity, which can help your bottom line.

We compared the systems to their legacy counterparts on tasks that workers do
every day—often several times. We also used industry-standard benchmarks to gauge
system performance and measure the battery life of the laptops we tested. Here’s how
we compared them:

e Everyday tasks
e  Graphics performance
e General system performance
e Battery life
To see how much better the new Intel Core i7 processor-based systems fared,

continue reading. For a look at the benchmarks we used, see Appendix A. See Appendix

B for detailed system configurations and Appendix C for the steps we took for testing.

TIME TO COMPLETE EVERYDAY TASKS

Time to boot

A system that boots quickly helps users get to work quicker. In our tests, the
new desktop and new laptop systems booted more quickly than the previous-

generation systems—up to 41.0 percent more quickly (see Figure 1).
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Time to open Adobe Photoshop Elements 12 and convert a project to JPEG
Adobe® Photoshop® Elements is a powerful application that can take a while to

launch and to convert a project from one format to another. In our tests, the two new

systems took less time to perform both of these tasks than the previous-generation

systems did (see Figure 2).
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Time to open Adobe Premiere Elements 12 and encode a file to MPEG
Adobe Premiere® Elements is another application that can take a while to

launch. When done many times a day, this can eat into a worker’s productivity. In our

tests, the two new systems took less time to launch and encode a file than the previous-

generation systems did (see Figure 3). The biggest wins were in encoding a project to

MPEG. The new desktop system did this in less than one-third the time of the older

desktop system and the new laptop saved almost one minute.
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MEASURING GRAPHICS PERFORMANCE
Futuremark 3DMark Vantage v1.1.2

A system’s graphics performance is critical to those who work with graphics

programs, but can also effect general responsiveness for those who don’t. We used the

industry-standard Futuremark® 3DMark® Vantage 1.1.0 benchmark to measure the

graphics performance of the four systems we tested. We ran 3DMark Vantage with the

Performance preset, which runs at 1,280 x 1,024 and is designed for mid-range

hardware. In our tests, the new systems outperformed their previous-generation

counterparts across the board (see Figure 4).
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MEASURING SYSTEM PERFORMANCE

Digital media performance
Many folks rely on their desktop and laptop systems to handle digital media. We

used the HDXPRT benchmark to see how well our four systems perform such tasks as
organizing and editing photos, videos and music. Figure 5 shows the overall HDXPRT
Create HD Score for the four systems. The newer desktop and laptop achieved scores
85.0 percent and 51.2 percent better than their previous-generation counterparts,
indicating they would be better able to meet a number of media creation and
manipulation demands.
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Overall system performance
BAPCo® SYSmark® 2012 tests the performance of systems in a number of areas

of business use to determine overall performance. As Figure 6 shows, the new HP
EliteDesk 800 G1 outperformed the older desktop system by 94.0 percent and the new
HP EliteBook Folio 9470m outperformed the older laptop by 20.0 percent.
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Futuremark PCMark 7 Advanced v1.4.0

Futuremark PCMark® 7 Advanced is another system performance test that
covers storage, computation, image and video manipulation, Web browsing, and
gaming. As Figure 7 shows, The HP EliteDesk 800 G1 achieved a 61.3 percent higher
score than the legacy desktop, and the HP EliteBook Folio 9470m scored 110.3 percent
better than the older laptop.
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MEASURING BATTERY LIFE (LAPTOPS ONLY)

Measuring battery life w

Figure 8: MobileMark 2012
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CONCLUSION

ith BAPCo MobileMark 2012

Laptops with long battery life are ideal for today’s worker, who is often mobile.
If a laptop runs longer without charge, employees aren’t faced with the hassles of
plugging in on the go.

We compared the battery life of the two laptops using MobileMark® and found
that the new HP EliteBook Folio 9470m lasted one hour 26 minutes longer on a single
charge than the legacy system did (see Figure 8).
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Upgrading from older laptops and desktops to newer ones can save employees
time on a number of tasks, which can really add up over the course of the workday, the
week, and even the year.

We found that the HP EliteBook Folio 9470m laptop delivered 30.3 percent
longer battery life than a legacy system and also performed most common tasks more
quickly, which would save workers time. Similarly, the HP EliteDesk 800 G1 Desktop Mini
improved upon an older system in most common worker tasks, including converting a
file to an MPEG in less than one-third the time. This means that for workers who do
similar tasks, upgrading to an HP EliteBook Folio 9470m laptop or HP EliteDesk 800 G1
Desktop Mini could reduce wait time and increase productivity.
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APPENDIX A - THE BENCHMARKS WE USED

In this section, we present a brief overview of the benchmarks we used in our

testing.

Futuremark 3DMark Vantage

HDXPRT 2012

BAPCo SYSmark 2012

Futuremark 3DMark Vantage is a benchmark designed to rate the performance
of DirectX® 10 gaming PCs. It includes two graphics tests, two CPU tests, and six feature
tests. The benchmark reports both graphics and CPU scores, as well as an overall
3DMark score to rate overall gaming performance.

For more information on 3DMark Vantage, see
www.3dmark.com/3dmarkvantage/.

The High Definition eXperience & Performance Ratings Test (HDXPRT) 2012 is a
benchmark that evaluates the capabilities of PCs in consumer digital media uses,
including

e Media Organizer
e Media Creator

e Photo Blogger

e Video Producer
e Music Maker

For more information on HDXPRT 2012, see www.hdxprt.com.

BAPCo SYSmark 2012 is an application-based benchmark that tests performance
in the following office workload scenarios: office productivity, media creation, Web
development, data/financial analysis, 3D modeling, and system management. SYSmark
2012 records the time the system takes to complete each individual operation in each
scenario. For more information on this benchmark, see

www.bapco.com/products/sysmark2012/.

Futuremark PCMark 7 Advanced

Futuremark PCMark 7 includes seven PC tests for Windows® 7 and Windows 8
combining more than 25 individual workloads covering storage, computation, image and
video manipulation, Web browsing, and gaming. Specifically designed to cover the full
range of PC hardware from netbooks and tablets to notebooks and desktops, PCMark 7
offers complete PC performance testing for Windows 7 and Windows 8 for home and
business use. For more information on this benchmark, see

www.pcmark.com/benchmarks/pcmark7/.
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BAPCo MobileMark 2012

MobileMark 2012 is an industry-standard benchmark that provides a battery life

rating and a performance rating based on common office scenarios. In our tests, we

focus solely on the battery life rating. MobileMark 2012 applications and workloads

specific to mobile systems. These include office activities like file and document

management, data processing, and rich content creation. This module provides a score

for battery life of the tested applications.

MobileMark 2012 includes the following applications with their corresponding

tasks:

ABBYY® FineReader™ Pro 11
Adobe Acrobat® Pro X

Adobe Flash® Player 11

Adobe Photoshop CS5 Extended 12.04
Adobe Photoshop Elements 10
Adobe Premiere® Pro CS 5.5
CyberLink® PowerDVD® Ultra 11
Microsoft® Excel® 2010 SP1
Microsoft Internet Explorer® 9
Microsoft Outlook® 2010 SP1
Microsoft PowerPoint® 2010 SP1
Microsoft Windows Media® Player
Microsoft Word 2010 SP1

Mozilla® Firefox® 10.0.2

WinZip® Pro 16

MobileMark 2012 measures system battery life in minutes. It records system

battery life at the start of the benchmark and repeats the workload until the system

battery life is depleted, or until the system powers down due to low battery life.

MobileMark 2012 records a timestamp once per minute. At the end of the

benchmark, it compares the beginning timestamp to the final (last recorded) timestamp.

MobileMark 2012 derives its system battery life rating as the number of minutes

between the start and end timestamps.
For more information on this benchmark, see

www.bapco.com/products/mobilemark2012/index.php.
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APPENDIX B — SYSTEM CONFIGURATION INFORMATION

Figure 9 and 10 provide detailed configuration information for the test systems.

System HP Compaq 8000 HP EliteDesk 800
Elite Convertible Minitower G1 DM Business PC

General

Number of processor packages 1 1

Number of cores per processor 2 4

Number of hardware threads per 1 )

core

Total number of processor threads in ) 8

system

System power management policy Balanced Balanced

Processor power-saving option EIST EIST

CPU

Vendor Intel Intel

Name Core 2 Duo Core i7

Model number E8400 4765T

Stepping EO Co

Socket type Socket LGA775 Socket 1150 LGA

Core frequency (GHz) 3.0 2.0 (Turbo Boost 3.0 GHz)

Bus frequency 1,333 DMI 2 (5 GT/s)

L1 cache 2x32KB+2x32KB 4x32KB+4x32KB

L2 cache 6 MB 4 x 256 MB

L3 cache N/A 8 MB

Platform

Vendor Hewlett-Packard Hewlett-Packard

Motherboard model number 3647h 1825

Motherboard chipset Intel Q45/Q43 Intel Q87

BIOS name and version

Hewlett-Packard 786G7 v01.13
(07/20/2011)

Hewlett-Packard LO4 v02.02
(03/18/2014)

Memory module(s)

Vendor and model number

Samsung M378B5673EH1-CH9

Samsung M471B5173QHO0-YKO

Type

PC3-10600

PC3-12800

Speed (MHz) 667 1,600

Speed running in the system (MHz) 533 1,600
T|m|ng/Latency (tCL-tRCD-tRP- 2.7.7-20 11-11-11-28
tRASmMIn)

Size (MB) 2,048 4,096
Number of memory module(s) 2 1

Total amount of system RAM (GB) 4 4

Chip organization (single- . .
sided/double-sided) Double-sided Double-sided
Channel (single/dual) Dual Single
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System HP Compaq 8000 HP EliteDesk 800
Elite Convertible Minitower G1 DM Business PC

Hard disk

Vendor and model number Seagate® ST3320418AS HGST HTS725050A7E6300

Number of disks in system 1 1

Size (GB) 320 500

Buffer size (MB) 16 8

RPM 7,200 5,400

Type SATA 3.0 Gb/s SATA 3.0 Gb/s

Controller Intel Express Chipset SATA RAID Intel 8 Series/C220 Chipset Family
Controller SATA AHCI Controller

Driver Intel 10.1.0.1008 (11/06/2010) Intel 12.9.0.1001 (10/28/2013)

Operating system

Name Windows 7 Professional x64 Windows 7 Professional x64

Build number 7600 7600

Service Pack 1 1

File system NTFS NTFS

Kernel ACPI x64-based PC ACPI x64-based PC

Language English English

Microsoft DirectX version DirectX 11 DirectX 11

Graphics

Vendor and model number Intel GMA 4500 Intel HD Graphics 4600

Type Integrated Integrated

Chipset Intel 4 Series Express Chipset Family Intel HD Graphics Family

BIOS version 2066.0 2177.0

Total available graphics memory 1695 1,696

(MB)

Dedicated video memory (MB) 64 64

System video memory (MB) 0 0

Shared system memory (MB) 1,631 1,632

Resolution

1,280 x 1,024

1,280x 1,024

Driver

Intel 8.15.10.2413 (06/03/2011)

Intel 10.18.10.3621 (05/16/2014)

Sound card/subsystem

Vendor and model number

Realtek® High Definition

Realtek High Definition

Driver Realtek 6.0.1.6383 (05/31/2011) Realtek 6.0.1.7224 (04/15/2014)

Ethernet

Vendor and model number Intel 82567LM-3 Gigabit Controller Intel 1217-LM

Driver Intel 12.10.13.0 (12/16/2013) Intel 12.10.30.5890 (09/22/2013)
Wireless

Vendor and model number N/A Intel Dual band Wireless-N 7260

Driver N/A Intel 16.10.0.5 (01/28/2014)

Optical drive(s)

Vendor and model number

HP CDDVDW TS-H653R

N/A

Type

DVD-RW

N/A
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System HP Compaq 8000 HP EliteDesk 800
Elite Convertible Minitower G1 DM Business PC

USB ports

Number 10 6

Type 2.0 3.0

Other N/A 2 Display Ports

Monitor

Type ViewSonic® VG730m ViewSonic VG730m

Screen size 17" 17"

Refresh rate (Hz) 60 60

Figure 9: Detailed information for the tested desktop systems.

System HP EliteBook 8460p HP EliteBook 9470m

General

Number of processor packages 1 1

Number of cores per processor 2 2

Number of hardware threads per 5 5

core

Total number of processor threads in 4 4

system

System power management policy Balanced HP Optimized

Processor power-saving option EIST EIST

System dimensions
(length x width x height)

13-3/4" x 9-3/8" x 1-3/8"

13-1/4" x 9-1/8" x 3/4"

System weight 5 lbs. 7 oz. 3 lbs. 10 oz.

CPU

Vendor Intel Intel

Name Core i5 Corei7

Model number 2520M 3687U

Stepping D2 El

Socket type and number of pins Socket 988B rPGA Socket 1023 FCBGA
Core frequency (GHz) 2.50 (Max Turbo 3.20) 2.10 (Max Turbo 3.30)
L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 512 KB (256 KB per core) 512 KB (256 KB per core)
L3 cache 3 MB 4 MB

Platform

Vendor HP HP

Motherboard model number 161C 18DF

Motherboard chipset Intel QM67 Intel QM77

BIOS name and version

HP 68SCF Ver. F.42 (07/15/2013)

HP 68IBD Ver. F.48 (01/13/2014)

Memory module(s)

. Samsung
Vendor and model number Hynix HMT351S6BFR8C-H9 M471B1G73DB0-YKO
Type PC3-10600 PC3-12800
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System HP EliteBook 8460p HP EliteBook 9470m

Speed (MHz) 1,333 1,600

Speed running in the system (MHz) 1,333 1,600

Timing/Latency

(tCL-tRCD-tRP-tRASmMin) 9-9-9-24 11-11-11-28

Size (MB) 4,096 8,192

Number of memory module(s) 1 1

Total amount of system RAM (GB) 4 8

Chip organization . .
Double- Double-

(single-sided/double-sided) ouble-sided ouble-sided

Channel (single/dual) Single Single

Hard disk

Vendor and model number

Hitachi HTS725032A9A364

Intel SSDSC2BF240A4H

Number of disks in system 1 1

Size (GB) 320 240

Buffer size (MB) 16 N/A

RPM 7,200 N/A

Type SATA 3.0 Gb/s SATA 6.0 Gb/s

Controller Intel Mobile Express Chipset SATA Intel 7 Series Chipset Family SATA
AHCI Controller AHCI Controller

Driver Intel 10.1.2.1004 (01/12/2011) Intel 11.2.0.1006 (05/30/2012)

Operating system

Name Windows 7 Professional x64 Windows 7 Professional x64

Build number 7600 7600

Service Pack 1 1

File system NTFS NTFS

Kernel ACPI x64-based PC ACPI x64-based PC

Language English English

Microsoft DirectX version DirectX 11 DirectX 11

Graphics

Vendor and model number AMD Radeon™ HD 6470M Intel HD Graphics 4000

Type Discrete Integrated

Chipset ATI™ Radeon HD 6470M Intel HD Graphics Family

BIOS version BR39846.001 2130.0

Total available graphics memory 2,791 1,696

(MB)

Dedicated video memory (MB) 1,024 64

System video memory (MB) 0 0

Shared system memory (MB) 1,767 1,632

Resolution

1,366 x 768 x 32-bit

1,600 x 900 x 32-bit

Driver

ATI Technologies Inc. 13.200.0.0
(09/11/2013)

Intel 8.15.10.2778 (06/06/2012)

Sound card/subsystem

Vendor and model number

IDT High Definition Audio CODEC

| IDT High Definition Audio CODEC
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System HP EliteBook 8460p HP EliteBook 9470m

Driver IDT 6.10.6433.0 (10/24/2012) IDT 6.10.6425.0 (08/19/2012)

Ethernet

Vendor and model number Intel 82579LM Gigabit Intel 82579LM Gigabit

Driver Intel 12.6.45.0 (05/15/2013) Intel 11.16.96.0 (03/15/2012)

Wireless

Vendor and model number Intel Centrino Advanced-N 6205 Intel Centrino Advanced-N 6235

Driver Intel 15.2.0.19 (06/03/2012) Intel 15.9.0.5 (06/16/2013)

Modem

Vendor and model number LS| HDA Modem N/A

Driver LSI 2.2.100.0 (01/26/2010) N/A

Optical drive(s)

Vendor and model number HP GT31L N/A

Type DVD-RW N/A

USB ports

Number 4 3
2xUSB3.0,1xUSB2.0,1xUSB

Type 2.0/eSATA 3 xUSB 3.0

Other Media card reader Display Port

IEEE 1394 ports

Number 1 | 0

Monitor

LCD type HD LED WXGA SVA HD+

Screen size 14" 14"

Refresh rate (Hz) 60 60

Battery

Type HP HSTNN-DB2G HP BTO4XL

Size (length x width x height) 8" x 1-7/8" x 3/4" 8-1/8" x 5-7/8" x 1/4"

Rated capacity 5600mAh / 11.1V (62Wh) 3400mAh / 14.8V (52Wh)

Weight (0z.) 11 12

Figure 10: Detailed information for the tested notebook systems.
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APPENDIX C— HOW WE TESTED
MEASURING TIME TO BOOT

Time to boot

1. Simultaneously start the timer and boot the system.

2. Stop the timer when the word Start appears.

3. Record the result as the Boot time.

4. Repeat steps 1 through 3 two more times, and report the median of the three runs.

MEASURING TIME TO OPEN APPLICATIONS

Time to open Adobe Photoshop Elements 12 and convert a project to JPEG

Setting up the test

1. Download and install Photoshop Elements with default options from
www.adobe.com/cfusion/tdrc/index.cfm?product=photoshop elements&loc=en.

2. Copy the test Photoshop Elements test file to the desktop.

Running the test
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

3. After the command completes, wait 5 minutes before running the test.

4. Simultaneously double-click the Adobe Photoshop Elements test file, and start the stopwatch.
5. Stop the stopwatch when the file is loaded into Photoshop Elements.

6. Click File->Save As.

7. Select JPEG from the drop down format menu and enter a file name.

8. Click Save.

9. In JPEG Options, slide the file size bar all the way to the right for the largest file (12).
10. Simultaneously click OK, and start the stopwatch.

11. Stop the stopwatch when the progress bar disappears and the curser stops spinning.
12. Shut down the system.

13. Repeat steps 1 through 12 two more times, and report the median of three runs.

Time to open Adobe Premiere Elements 12 and encode a file to MPEG

Setting up the test

1. Download and install Premiere Elements with default options from
www.adobe.com/cfusion/tdrc/index.cfm?product=premiere elements&loc=us.

2. Copy the Adobe Premiere Elements test file to the desktop.

Running the test

1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
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c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

Simultaneously double-click the Adobe Premiere Elements test file, and start the stopwatch.
Stop the stopwatch when the project is loaded into Adobe Premiere Elements.

Click the Share tab and select Computer.

Select MPEG, enter a file name, and simultaneously click Save, and start the stopwatch.
Stop the stopwatch when the progress bar disappears and the Done button appears.

. Shut down the system.

10. Repeat steps 1 through 9 two more times, and report the median of three runs.

©ENOYU AW

MEASURING GRAPHICS PERFORMANCE
3DMark

Installing 3DMark Vantage v1.1.2
1. Download the 3DMark Vantage Windows package from www.futuremark.com/benchmarks/3dmark/all.
2. Install 3DMark Vantage with the default options by double-clicking the 3DMark installer.exe file.
a. Atthe Welcome screen, click Next.
b. Atthe License Agreement screen, click | accept the terms of the license agreement, and click Next.
c. Atthe Setup Type screen, click Express, and click Next.
d. At the Ready to Install the Program screen, click Install.
3. When the 3DMark Read Me page appears in your Web browser, review the document, and click Close when you are
finished.
4. Atthe Setup Complete screen, click Finish.
5. Launch 3DMark Vantage by double-clicking on the 3DMark Vantage desktop icon. Enter the registration code, and
click Register.
6. Exit 3DMark Vantage.

Running 3DMark Vantage v1.1.2

1. Boot the system and bring up a command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click Run as administrator button.

2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
3. Do not interact with the system until the command completes.
4. After the command completes, wait 5 minutes before running the test.
5. Double-click the 3DMark Vantage desktop icon to launch the benchmark.
6. Inthe 3DMark Main section, click the Preset pull-down menu arrow, and select Performance.
7. Click the Options tab, then click the Graphic Tests tab, and ensure that both tests are selected.
8. Click the CPU Tests tab, and ensure that both tests are selected.
9. Click the Graphic Tests tab, and ensure that both tests are selected.
10. Click the Feature Tests tab, and deselect all six tests by clicking the check mark by each title.
11. Click Run Benchmark.
12. When the benchmark run completes, record the results.
13. Perform steps 1 through 12 two more times, and report the median of the three runs.
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MEASURING SYSTEM PERFORMANCE

HDXPRT 2012

Setting up the test

1. Insert the HDXPRT DVD-ROM into your DVD drive.

2. At the HDXPRT Install screen, tlick Install HDXPRT.

3. Accept the HDXPRT end user license agreement.

4. After the setup is complete, select Yes, | want to restart my computer now, and click Finish.

Running the test

1. Click the HDXPRT 2012 shortcut on the desktop.

2. Click Run HDXPRT.

3. Enter a test name, choose 3 iterations, and click Run.

4. The Results Screen automatically appears at the end of a successful run. The test results files are found in the
C:\ProgramFiles\HDXPRT\Reports\<TestName> directory.

BAPCo SYSmark 2012 v1.5.4.317

Antivirus software conflicts
SYSmark 2012 is not compatible with any virus-scanning software, so we uninstalled any such software that was

present on the notebook PCs before we installed the benchmark.

Pre-installed software conflicts
SYSmark 2012 installs the following applications, which its test scripts employ:

ABBYY FineReader Pro 10.0
Adobe Acrobat Pro 9

Adobe Dreamweaver® CS5
Adobe Flash Player 10.1

Adobe Photoshop CS5 Extended
Adobe Premiere Pro CS5

Adobe After Effects® CS5
Autodesk® 3ds Max® 2011
Autodesk AutoCAD® 2011
Google SketchUp® Pro 8
Microsoft Excel 2010

Microsoft Internet Explorer 8 (or newer version, if already installed)
Microsoft Outlook 2010
Microsoft PowerPoint 2010
Microsoft Word 2010

Mozilla Firefox 3.6.8

WinZip Command Line 3.2

If any of these applications are already on the system under test, they will cause problems with the benchmark
due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all conflicting pre-
installed software applications, including different versions of any of the programs SYSmark 2012 uses.

Setting up the test
1. Disable the User Account Control.
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Click Start—>Control Panel.

At the User Accounts and Family Safety settings screen, click Add or remove user account.

At the User Account Control screen, click Continue.

Click Go to the main User Accounts page.

At the Make changes to your user account screen, click Turn User Account Control on or off.

At the User Account Control screen, click Continue.

Uncheck Use User Account Control to help protect your computer, and click OK.

At the You must restart your computer to apply these changes screen, click Restart Now.

2. Purchase and install SYSmark 2012 v1.5.4.317 with default settings from
https://www.bapcostore.com/store/product.php?productid=161858&cat=251&page=1.

3. Launch SYSmark 2012 by double-clicking the desktop icon and select Configuration.

4. Select all options and click Apply.

5. Reboot the system.

Sm 0 o0 T

Running the test

1. Launch SYSmark 2012 by double-clicking the desktop icon.

2. Enter a Project name.

3. Select 3 Iterations, check the box beside Conditioning Run, and click Run Benchmark.

4. When the benchmark completes and the main SYSmark 2012 menu appears, click Save FDR to create a report.

Futuremark PCMark 7 Advanced v1.4.0

Setting up the test

1. Download the PCMark 7 installer exe Windows package from www.futuremark.com/benchmarks/pcmark?.

2. Install PCMark 7 with the default options by double-clicking the PCMark installer exe file.

3. Launch PCMark 7 by clicking on the PCMark 7 desktop icon. Enter the registration code, click Register, and click OK.
4. Exit PCMark 7.

Running the test

Reboot the system.

Double-click the PCMark 7 desktop icon to launch the benchmark.

Select all test suites.

Click Run Benchmark.

When the benchmark run completes record the results.

Repeat steps 1 through 5 two more times, and report the median of the three runs.
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MEASURING BATTERY LIFE (NOTEBOOKS ONLY)
Measuring battery life with MobileMark 2012

Avoiding antivirus software conflicts
MobileMark 2012 is not compatible with any virus-scanning software, so we uninstalled any such software

present on the notebook PCs before we installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 2012 installs the following applications, which its test scripts employ:

e ABBYY FineReader Pro 11

e Adobe Acrobat Pro X

e Adobe Flash Player 11

e Adobe Photoshop CS5 Extended 12.04
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e Adobe Photoshop Elements 10
Adobe Premiere Pro CS 5.5
CyberLink PowerDVD Ultra 11
Microsoft Excel 2010 SP1
Microsoft Internet Explorer

e  Microsoft Outlook 2010 SP1

e Microsoft PowerPoint 2010 SP1
e Microsoft Windows Media Player
e  Microsoft Word 2010 SP1

e Mozilla Firefox 10.0.2

e WinZip Pro 16

If any of these applications are already on the system under test, they could cause problems with the
benchmark due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all
conflicting pre-installed software applications, including different versions of any of the programs MobileMark 2012
uses.

Adjusting display brightness and power settings
The brightness of a notebook’s display affects its battery life. Therefore, BAPCo requires that, before you test

with MobileMark 2012, you do the following step: make sure the brightness of the notebook’s monitor is greater than or
equal to 150 nits on a completely white screen while the notebook is unplugged and running on battery power. The
measurement follows the standards from the Video Electronics Standards Association (www.vesa.org).

We complied with this standard for all the tests we ran by setting the notebook PC’s brightness as close to 150
nits as we could without going below that brightness level. We used the following procedure before we started each
test. Note: This procedure assumes we began with the notebook plugged into the power supply.

1. To create a completely blank, white screen, open Microsoft Paint by clicking Start->All Programs—>
Accessories—>Paint.
Press Ctrl+W to open the Resize and Skew dialog.
Under Horizontal and Vertical enter 200, and click OK.
Click the View tab.
Click Full screen to view a white screen.
Wait 45 minutes to allow the screen to warm.
Unplug the notebook from the power supply, and measure the display’s brightness using a luminance meter in the
center of the screen. (We used the Gossen® Mavolux 5032C.)
8. If the reading is below or significantly greater than 150 nits, adjust the screen brightness to as close to 150 nits,
without going under, as possible. Then retest:
a. Click the Windows start button, and type power options inthe Windows Start Search box.
b. Click Change plan settings.
c. Click Change advanced power settings.
d. Expand the Display option, and change the Display brightness on battery and plugged in to the correct
percentage that produces no less than 150 nits.
9. Allow the notebook to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or
down as necessary.
10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another
reading.

NowukswnN
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Using the MobileMark built-in Configuration Tool

1.

This tool supports three levels of configuration:

Only makes changes that are REQUIRED in order for the benchmark to run.

2. Additionally, makes changes that are RECOMMENDED for repeatable results.

3. Additionally, makes OPTIONAL changes that help ensure best results.

The Configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

Disables User Account Control (UAC)
Disables Windows Update

Disables System Sleep and Hibernate

Sets Screen Dimming Timeout (2 minutes)
Disables Low Battery Actions

Disables Network Proxies

Disables Autorun for Optical Drive

Level 2 - Recommended

Create BAPCo power scheme

Set Power Plan Type to balanced

Disables Windows Firewall

Disables Windows Sidebar/Gadgets
Disables Windows Pop-ups

Disables Incoming Remote Desktop Connections
Disables Windows Error Reporting

Disables Screen Saver and Monitor Timeout
Sets CPU Adaptive Mode

Disables Desktop Slideshow

Disables Disk Defrag

Level 3 - Optional

Installing MobileMark 2012 and configuring the system for testing

ok wWwNE

Sets Hard Disk Timeout

Disables Windows Defender
Disables System Restore

Ignores Laptop Lid Close

Sets Maximum Display Brightness
Disables Adaptive Brightness

We chose all options listed - Level 3- in the Configuration tool.

Verify that the wireless adapter is enabled and connected to a wireless router that is not connected to the Internet.

Insert the MobileMark 2012 Install DVD into the notebook PC’s DVD drive.
When the Autoplay menu appears, click Run MobileMark2012_Setup.exe.

At the Welcome screen, click Next.
Enter the serial number, and click Next.
Accept the license agreement, and click Next.
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10.
11.
12.
13.
14,
15.

At the Choose Components screen, select Full, and click Next.

At the Choose Install Location screen, accept the default location of C:\Program Files (x86)\BAPCo\MobileMark2012,

and click Next.

At the Choose Start Menu Folder screen, click Install.

Insert Disc 2 when prompted.

At the InstallShield Wizard Complete screen, click Finish.

Launch MobileMark 2012.

Click Configuration and choose only the Required options.

Click Apply, and restart the computer when prompted.

Adjust the screen brightness to no less than 150 nits:

a. Click the Windows start button, and type power options inthe Windows Start Search box.

b. Click Change plan settings.

c. Click Change advanced power settings.

d. Expand the Display option, and change the Display brightness on battery and plugged in to the correct
percentage that produces no less than 150 nits.

Conditioning the battery

1.
2.

E

9.

Plug the AC power adapter into the notebook PC, and completely charge the battery.

Install MobileMark 2012, following the steps we outlined in the Installing MobileMark 2012 section earlier in this
section.

Double-click the MobileMark 2012 icon on the desktop.

Click the Office Productivity icon.

Type System Conditioning asthe name for this test in the Project Name, check the box next to conditioning,
and click Continue.

If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close
MobileMark 2012, and correct the problem(s) before proceeding.

When prompted, unplug the AC power adapter. The Office Productivity test begins immediately.

The test is complete when the notebook PC has fully depleted its battery and is no longer operational when running
on battery power.

Plug the AC power adapter into the notebook PC, and completely charge the battery.

Measuring battery life with MobileMark 2012

PWNPE
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We performed the following steps to run the MobileMark 2012 Office Productivity benchmark:

Double-click the MobileMark 2012 icon on the desktop.

Select the Office Productivity test by clicking the Office Productivity icon.

Enter a name for this test in the Project Name field, and click Continue.

If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close
MobileMark 2012, and correct the problem(s) before proceeding.

When prompted, unplug the AC power adapter. The test begins immediately.

The Office Productivity test is complete when the notebook PC has fully depleted its battery and is no longer
operational when running on battery power.

We executed the MobileMark 2012 Office Productivity test three times on the system and took the median

battery life run as the representative score for that test.
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Getting the MobileMark 2012 results
After each MobileMark Productivity 2012 test completed, we plugged the AC power adapter into the notebook

PC and turned on the system. MobileMark 2012 started automatically after the system booted, then analyzed the test
scores and opened the Test Results Viewer with the results from the last test.
To submit these results to BAPCo, we saved the test results by performing the following steps:

1. Click Save.
2. Enter a name and select FDR to save the results as an FDR file.
3. Click Save again, and select PDF to save the results as a PDF file.
4. Browse to the Documents directory where the result FDR and PDF files were saved.
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ABOUT PRINCIPLED TECHNOLOGIES

» We provide industry-leading technology assessment and fact-based
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researching new technologies, to developing new methodologies, to
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1007 Slater Road, Suite 300
Durham, NC, 27703 When the assessment is complete, we know how to present the results to

www.principlectechnologies.com a broad range of target audiences. We provide our clients with the
materials they need, from market-focused data to use in their own
collateral to custom sales aids, such as test reports, performance
assessments, and white papers. Every document reflects the results of
our trusted independent analysis.

We provide customized services that focus on our clients’ individual
requirements. Whether the technology involves hardware, software, Web
sites, or services, we offer the experience, expertise, and tools to help our
clients assess how it will fare against its competition, its performance, its
market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked
together in technology assessment for over 20 years. As journalists, they
published over a thousand articles on a wide array of technology subjects.
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
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Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE.
ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED
TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR
DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES,
INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S
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Upgrading laptops and desktops to the new HP EliteBook Folio A Principled Technologies test report 23
9470m and HP EliteDesk 800 G1 Desktop Mini Business PC


http://www.principledtechnologies.com

